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Streamline Series VNA & PC setup 
procedure and 
its Troubleshooting tips

Keysight Technologies

11-Dec-2025

Streamline Series VNA A model:

P5000A,P5001A,P5002A,P5003A,P5004A,P5005A,P5006A,P5007A,P5008A

P5020A,P5021A,P5022A,P5023A,P5024A,P5025A,P5026A,P5027A,P5028A

P9370A,P9371A,P9372A,P9373A,P9374A,P9375A

Streamline Series VNA B model:

P5000B,P5001B,P5002B,P5003B,P5004B,P5005B,P5006B,P5007B,P5008B

P5020B,P5021B,P5022B,P5023B,P5024B,P5025B,P5026B,P5027B,P5028B

P9370B,P9371B,P9372B,P9373B,P9374B,P9375B,P9377B,P9382B,P9384B

P5027M, P5028M
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When using  a PC that was used for another purpose, we recommend to 

perform system recovery before setting up PC configurations for 

Streamline Series VNA. System Recovery prevents conflicts between the 

registries/drivers which were previously configured and the ones that will 

be configured for the Streamline Series VNA.
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1. Select PC

PC Requirements for Streamline Series VNA control

Notes of PC specifications for Streamline Series VNA B model:

1. Connections via USB2.0 cable or USB3.x cable are not supported.

Connection via USB-to-Thunderbolt adapter is not supported.

2. Desktop PCs usually don’t have adequate Thunderbolt 3+ support by default. When configuring a Desktop 

PC on the manufacturer's website, you must select an option to include a PCIe Thunderbolt 3+ card 

installed in the PC. It is best to use one which comes from the original manufacturer of the whole PC, since 

a third-party Thunderbolt 3+ PCIe card might not work.

Contact PC maker about valid Thunderbolt 3+ PCIe card, if needed.

See Thunderbolt PC and Streamline Series VNA B model compatibility list in Appendix.

3. If Thunderbolt 3+ PC cannot work with Streamline Series VNA B model, contact Keysight. For more details, 

see Contact Keysight - issue sharing in Appendix.

Go to Table 49 of Streamline series VNA A model Data Sheet or

          Table 53 of Streamline series VNA B model Data Sheet or 

    Table 26 of Streamline series VNA B P5027M/P5028M(*1) Data Sheet (*2) for External PC System 

Requirements.

(*1) External PC requirements are identical to VNA B. P502xM leverages VNA B platform.

(*2) Contact Keysight for data sheet.

https://www.keysight.com/us/en/assets/7018-06469/data-sheets/5992-3606.pdf
https://www.keysight.com/us/en/assets/3121-1235/data-sheets/Streamline-Series-Vector-Network-Analyzer-B-models.pdf
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Most PC makers provide a support assistant tool. We recommend using that tool 

to install the latest version of the application software and drivers.

2-3 Thunderbolt  control center app and Thunderbolt  drivers

      [for Streamline Series VNA B model only] 

2-7 Windows Registry [for Streamline Series VNA B model only] 
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2. Update current PC configurations

Launch Windows Update and check for updates

① Enter Windows Update at Windows Search

② Select Windows Update settings

③ Select Check for updates

     then download and install the updates

2-1. Windows Update

①

②

③
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2. Update current PC configurations

Step-1: Launch System Information

① Enter System Information at Windows Search

② Select System Information

[result] the current BIOS version/Date is shown in System Information.

2-2. BIOS 

①

②
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2. Update current PC configurations

Step-2: Visit your PC maker’s Support page (See PC makers’ driver download page in appendix) and 

check if installed PC BIOS (UEFI) is latest. 

Step-3: If not, download and install the latest version.

2-2. BIOS 
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2. Update current PC configurations

2-3. Thunderbolt generation and driver version [for Streamline Series VNA B model only]

Step-1: Launch Thunderbolt Control Center and check Thunderbolt generation and driver version

① Enter Thunderbolt at Windows Search

② Select Thunderbolt Control Center

③ Select hamburger menu

④ Select About 

[result] Thunderbolt Generation and driver version are shown.

①

②

③

④
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2. Update current PC configurations

2-3. Thunderbolt Software and Thunderbolt drivers [for Streamline Series VNA B model only] 

Step-2: Visit your PC maker’s Support page (See PC makers’ driver download page in appendix) and 

check if current Thunderbolt Software and Thunderbolt drivers are up to date. 

Step-3: If not, download and install the latest version.

If Thunderbolt Software is not installed, go to Troubleshooting tips 2-3-1.

Step-4: If PCIe tunneling is Disabled in Detail screen, go to Troubleshooting tips 2-3-2.
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2. Update current PC configurations

2-4. Keysight IO Libraries Suite

Step-1: Launch ‘Programs and Features’ and check IO Library Suites version

① Enter Control Panel at Windows Search

② Select Control Panel

③ Select Programs

④ Select Programs and Features

       

①

②

③

④



12

2. Update current PC configurations

[result] the versions of the programs are shown in Programs and Features

                   

2-4. Keysight IO Libraries Suite
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2. Update current PC configurations

2-4. Keysight IO Libraries Suite

Step-2: Visit www.keysight.com/find/iosuite and check if the current version is latest or not. 

Step-3: If not, uninstall IOLS and perform deep clean.

For more details, go to Keysight Uninstall IOLS and Deep Clean

Step-4: Download and install the latest version.

Do not use Keysight IO Libraries version: 2024 Update1, Build 21.0.47, release date: 2024-09-03.

① Select the download button

② Run the downloaded installer with administrator privilege

③ After the installation is completed successfully, re-boot the PC

④ If the installation is not completed successfully, go to Troubleshooting tips 2-4.

Notes on .NET Framework 3.5/2.0 and known issues:

    Keysight IO Libraries Suite 2021 or later does not install .NET Framework.

    If .NET Framework is needed, go to Troubleshooting tips 2-4-4.

Notes on Windows 11 PC:

    Install IO Libraries Suite 2023 (18.3.29324.3) or newer. 

    Earlier revisions will not be compatible with P50xxB/P93xxB/P502xM firmware on Windows 11. 

http://www.keysight.com/find/iosuite
https://edadocs.software.keysight.com/kkbopen/uninstall-and-deep-clean-a-malfunctioning-install-of-io-libraries-suite-682429352.html
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Step-1: Launch ‘Programs and Features’ and check VNA firmware version

① Enter Control Panel at Windows Search

② Select Control Panel

③ Select Programs

④ Select Programs and Features

       

2. Update current PC configurations

2-5. Keysight VNA firmware

①

②

③

④
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2. Update current PC configurations

[result] the versions of the programs are shown in Programs and Features

                   

2-5. Keysight VNA firmware 
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2. Update current PC configurations

2-5. Keysight VNA firmware

Step-2: Visit https://www.Keysight.com/find/pxiusbvna-firmware and 

check if the installed version is A.19.30.21 or later.

Step-3: If not, download and install A.19.30.21 or later. 

For Windows 11 host PC, download and install A.17.60.13 or later. 

For P5027M & P5028M, download and install A.19.30.08 or later. 

Recommended FW: A.19.30.21 or later.

① Select the download button

② Run the downloaded installer with administrator privilege

③ After the installation is completed successfully, re-boot the PC

④ If the installation did not complete successfully, go to Troubleshooting tips 2-5.

https://www.keysight.com/find/pxiusbvna-firmware
https://www.keysight.com/find/pxiusbvna-firmware
https://www.keysight.com/find/pxiusbvna-firmware
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2. Update current PC configurations

2-6. Keysight License Manager

If Keysight License Manager is not installed on your PC,

go to Keysight License Manager 5 Download | Keysight and 

① Select the download button

② Run the downloaded installer with administrator privilege

③ After the installation is completed successfully, re-boot the PC

④ If the installation does not complete successfully, go to Troubleshooting tips 2-6

Note: For floating licenses on a local server, KLM6 or PLM7 is required to install.

    For every other type of license, KLM5 is used.

    

KLM/ PLM is included in VNA firmware installer. 

PLM 7 is included in VNA FW A.19.00.09 and newer revisions, superseding KLM 6. 

2-7. Shutdown your PC once the installations are all done

https://www.keysight.com/us/en/lib/software-detail/instrument-firmware-software/keysight-license-manager-5-download-2225131.html
https://www.keysight.com/us/en/lib/software-detail/computer-software/keysight-license-manager-6-download-2977275.html
https://www.keysight.com/us/en/lib/software-detail/computer-software/pathwave-license-manager-download-3135511.html
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2. Update current PC configurations

2-7. Windows Registry [for Streamline Series VNA B model only] 

When your Streamline Series VNA B model is 2 modules model, some PCs which shows 

Code12 error in Device Manager do not recognize one of two VNA modules.

If Code12 error is shown, editing Windows Registry is required.

For more details, go to Troubleshooting Tips #3-6-1.

2-8. Shutdown your PC once the installations are all done

VNA B model may show Code31 error in Device Manager. 

The device is not working properly because Windows cannot load the drivers required 

for this device. 

For more details, go to Troubleshooting Tips #3-6-8.



19

2. Update current PC configurations

2-8. Tips on software installation/ uninstallation sequence 

If issue persists, 

① Remove all programs listed below (except the Thunderbolt software).

In case IOLS libraries fail to be uninstalled, to perform clean uninstallation of IO Libraries, 

refer to Troubleshooting Tips #2-4.

② Install Keysight IO Libraries Suite first.

③ Reboot the PC.

④ Install VNA firmware.

⑤ Reboot the PC. 

 

Proven latest versions of Key program (as of 3-Oct-2025)
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3. Connect Streamline Series VNA with PC

3-1. Connect the cable between Streamline Series VNA and PC
3-2. Plug in the appropriate AC adapter to Streamline Series VNA
3-3. Power on Streamline Series VNA, then confirm if the Power LED is green
3-4. Power on your PC
3-5. Confirm that Device License Changed dialog is shown in the right bottom of 
PC screen
3-6. Confirm that Device manager recognizes Streamline Series VNA
3-7. Confirm that Thunderbolt Control Center recognizes Thunderbolt device [for 
Streamline Series VNA B model only] 
3-8. Confirm that Keysight connection Expert recognizes Streamline Series VNA
3-9. Confirm that Keysight License Manager recognizes all the required licenses
3-10. Launch Network Analyzer 
3-11. Communicate remotely using LAN(TCPIP)
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3. Connect Streamline Series VNA with PC

3-1. Connect the cable between Streamline Series VNA and PC

P50xxA/P93xxA rear panel P50xxB/P93xxB rear panel

USB3.0 port x1

(USB Type-C)
Thunderbolt 3 port x2

(USB Type-C)

USB3.0 port

(USB Type-A)
Thunderbolt 3 port or

Thunderbolt 4 port

(USB Type-C)

USB3.0 cable 1
Thunderbolt 3 cable 2,3

Note:

1. Make sure to connect the USB3.0 cable included in the Streamline Series VNA (KPN: P9375-60010)

2. Make sure to connect the Thunderbolt 3 cable included in the Streamline Series VNA (KPN: P5000-60010).

3. The Thunderbolt 3 cable included in the Streamline Series VNA can used for connection with a Thunderbolt 4 PC
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3. Connect Streamline Series VNA with PC

3-2. Plug in the appropriate AC adapter to Streamline Series VNA

Streamline Series VNA (2-port model)2 rear panel

Keysight P/N 0950-61661

Keysight P/N 0950-61281

Streamline Series VNA (4- or 6-port model) rear panel

Note:

1. Make sure to connect the AC adapter included in the Streamline Series VNA.

2. 2-port model requires minimum 90W adapter (KPN: 0950-6128). 150W adapter (KPN: 0950-6166) can work, too.
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3. Connect Streamline Series VNA with PC

3-3. Power on Streamline Series VNA, then confirm if the Power LED is green

        If Power LED is not green, go to Troubleshooting tips 3-3

Power LED

Instrument Status LED
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3. Connect Streamline Series VNA with PC

3-4. Power on your PC

       

3-5. Confirm that Device License Changed dialog is shown in the right bottom of PC screen

If Device License Changed dialog is not shown, go to Troubleshooting tips 3-5

Make sure to supply power from AC/DC adapter for the PC.
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3. Connect Streamline Series VNA with PC

3-6. Confirm that Device manager recognizes Streamline Series VNA

① Enter Device Manager at Windows Search

② Select Device Manager

③ Select Keysight Technologies Modular Devices

[result] one P600X Chassis device and one or two VNA device(s) are shown.

            If P600X Chassis or VNA device(s) are not shown correctly, go to Troubleshooting tips 3-6.

     

1 module model 

(See 3-8-A)

2 modules model 

(See 3-8-B)

A model

B model

①

②

③
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3. Connect Streamline Series VNA with PC

3-7. Confirm that Thunderbolt Control Center recognizes Thunderbolt device [for Streamline Series VNA model only] 

①

②

③

④

① Enter Thunderbolt Control Center at Windows Search 

② Select Thunderbolt Control Center

③ Select hamburger menu

④ Select Attached devices

[result] P600X is connected in Attached Thunderbolt devices.

           If P600X is not connected, go to Troubleshooting tips 3-7.



27

3. Connect Streamline Series VNA with PC

3-8. Confirm that Keysight connection Expert recognizes Streamline Series VNA

① Enter Keysight Connection Expert at Windows Search 

② Select Keysight Connection Expert

or

                                                                                      ① Select       Show hidden icons

② Select       Keysight IO Libraries Suite

                                                                                      ③ Select Connection Expert

①

②

③

①

②
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3. Connect Streamline Series VNA with PC

3-8-A. Confirm that Keysight Connection Expert recognizes Streamline Series VNA A-model

[result] one P6001A/P6002A and one or two VNA device(s) are shown under PXI (PXI10)

            If they are not shown correctly, go to Troubleshooting tips 3-8.

     
A model with 2 modulesA model with 1 module A model with 1 module: 

P937xA, 

P500xA-200, 

P5020A-400/600, 

P5021A-400/600, 

P5022A-400/600, 

P5023A-400/600, 

P5024A-400/600

A model with 2 modules: 

P5020A-402, 

P5021A-402, 

P5022A-402, 

P5023A-402, 

P5024A-402, 

P5025A-400/402, 

P5026A-400/402, 

P5027A-400/402, 

P5028A-400/402
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3. Connect Streamline Series VNA with PC

3-8-B. Confirm that Keysight Connection Expert recognizes Streamline Series VNA B model

[result] one P6005A/P6006A and one or two VNA device(s) are shown under PXI (PXI0).

            If they are not shown correctly, go to Troubleshooting tips 3-8.

     
B model with 2 modulesB model with 1 module

B model with 1 module: 

P937xB-200,

P938xB-400,

P500xB-200, 

P5020B-400/600, 

P5021B-400/600, 

P5022B-400/600, 

P5023B-400/600, 

P5024B-400/600

B model with 2 modules: 

P5020B-402, 

P5021B-402, 

P5022B-402, 

P5023B-402, 

P5024B-402, 

P5025B-400/402, 

P5026B-400/402, 

P5027B-400/402, 

P5028B-400/402

P5027M-400

P5028M-400
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3. Connect Streamline Series VNA with PC

3-9. Confirm that Keysight License Manager recognizes all the required licenses

Step-1: Launch Keysight Software Manager and check your purchased licenses

① Go to http://www.keysight.com/find/softwaremanager
② Enter Order Number and Certificate Number of your Streamline Series VNA

③ Select Find Certificate

[result] all the purchased licenses are shown in Keysight Software Manager(KSM)

            

②

③

http://www.keysight.com/find/softwaremanager
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3. Connect Streamline Series VNA with PC

3-9. Confirm that Keysight License Manager recognizes all the required licenses

Step-2: Launch Keysight License Manager and check loaded licenses for Streamline Series VNA

① Enter Keysight License Manager at Windows Search

② Select Keysight License Manager

[result] all the loaded licenses to Streamline Series VNA are shown in Keysight License Manager (KLM)

Step-3: Compare purchased licenses in KSM with loaded licenses for Streamline Series VNA in KLM

Step-4: If required licenses are not shown, go to Troubleshooting tips 3-9.

①

②
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3. Connect Streamline Series VNA with PC

3-10. Launch Network Analyzer 

① Click the Network Analyzer icon on the PC desktop to execute the VNA application

② Select Streamline Series VNA model(s)

     If VNA model(s) not shown, go to Troubleshooting tips 3-6-1 and Troubleshooting tips 3-3-1-3

③ Select Run and then confirm if the Instrument Status LED is green

     If not, go to Troubleshooting tips 3-3-2

Note:

    If FPGA image in FW is different from FPGA image in VNA, the FW will require updating the VNA’s FPGA.

    It takes some time to complete the FPGA update. Until the completion, do not turn off the PC or VNA and

    do not pull off the cable between PC and VNA.

②

③

①

②

③

1 module model 2 modules model
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3. Connect Streamline Series VNA with PC

3-10. Launch Network Analyzer 

[result] measurement screen is shown.

            If VNA firmware halts or shows error message before showing the measurement screen,

            go to Troubleshooting tips 3-10.



34

3. Connect Streamline Series VNA with PC

3-11. Communicate remotely using LAN (TCPIP) 

Refer to Keysight Streamline Series VNA – LAN (TCPIP) communication setup

If remote communication does not work well, go to Troubleshooting tips 3-11. 

https://www.keysight.com/us/en/assets/9922-01395/reference-guides/Keysight-Streamline-Series-VNA-LAN-TCPIP-communication-setup.pdf
https://www.keysight.com/us/en/assets/9922-01395/reference-guides/Keysight-Streamline-Series-VNA-LAN-TCPIP-communication-setup.pdf
https://www.keysight.com/us/en/assets/9922-01395/reference-guides/Keysight-Streamline-Series-VNA-LAN-TCPIP-communication-setup.pdf
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4. Troubleshooting tips
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4. Troubleshooting tips
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4. Troubleshooting tips 1
1. PC requirements

Symptom Possible root cause Solution

#1-1

PCIe Thunderbolt card does not 

communicate with VNA properly on 

Desktop PC

Poor signal quality of PCIe 

Thunderbolt card or 

Thunderbolt cable

Go to Troubleshooting tips #3-10-4.

#1-2

Cannot install Keysight IO Libraries 

Suite and/or VNA firmware.

There are conflicts between 

the registries/drivers which 

were previously configured 

and the ones that will be 

configured for the Streamline 

Series VNA.

Step-1: 

① Download IO Libraries Suite direct download again

② Open the exe file with Administrator mode

③ Select Repair > Next > Finish

If the symptom still occurs,

Step-2: 

① Download Command Expert direct download

② Open the exe file with Administrator mode

③ Select Next > Repair >Next > Install > Finish

If the symptom still occurs,

Step-3: 

① Download BenchVue Platform direct download

② Open the exe file with Administrator mode

③ Select Install > Repair > Install > Install > Next > Finish

If the symptom still occurs,

Step-4: 

Perform system recovery of your PC before setting up PC configurations 

for Streamline Series VNA. 

https://www.keysight.com/main/redirector.jspx?action=ref&ckey=2175637&cname=EDITORIAL
https://www.keysight.com/main/redirector.jspx?action=ref&ckey=2151326&cname=EDITORIAL
https://www.keysight.com/main/redirector.jspx?action=ref&ckey=2417463&cname=EDITORIAL
https://www.keysight.com/main/redirector.jspx?action=ref&ckey=2417463&cname=EDITORIAL
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4. Troubleshooting tips 1
1. PC requirements

Symptom Possible root cause Solution

#1-3

BSOD (Blue Screen Of Death) is 

shown

Go to Windows 11 BSODs Automatic Repair and advanced 

troubleshooting options - Microsoft Community

Refer to Bug Check Code Reference - Windows drivers | Microsoft 

Learn for more details.

https://answers.microsoft.com/en-us/windows/forum/all/windows-11-bsods-automatic-repair-and-advanced/ba734742-9e1a-4911-8883-228966c8e6e5?from=GetHelpBCQR&CorrelationId=fa02def3-423c-49cf-975a-bc0f888a413e&ocid=OO_Core_NEU_GetHelp_DG_GetHelp_Solutions
https://answers.microsoft.com/en-us/windows/forum/all/windows-11-bsods-automatic-repair-and-advanced/ba734742-9e1a-4911-8883-228966c8e6e5?from=GetHelpBCQR&CorrelationId=fa02def3-423c-49cf-975a-bc0f888a413e&ocid=OO_Core_NEU_GetHelp_DG_GetHelp_Solutions
https://answers.microsoft.com/en-us/windows/forum/all/windows-11-bsods-automatic-repair-and-advanced/ba734742-9e1a-4911-8883-228966c8e6e5?from=GetHelpBCQR&CorrelationId=fa02def3-423c-49cf-975a-bc0f888a413e&ocid=OO_Core_NEU_GetHelp_DG_GetHelp_Solutions
https://answers.microsoft.com/en-us/windows/forum/all/windows-11-bsods-automatic-repair-and-advanced/ba734742-9e1a-4911-8883-228966c8e6e5?from=GetHelpBCQR&CorrelationId=fa02def3-423c-49cf-975a-bc0f888a413e&ocid=OO_Core_NEU_GetHelp_DG_GetHelp_Solutions
https://learn.microsoft.com/en-us/windows-hardware/drivers/debugger/bug-check-code-reference2
https://learn.microsoft.com/en-us/windows-hardware/drivers/debugger/bug-check-code-reference2
https://learn.microsoft.com/en-us/windows-hardware/drivers/debugger/bug-check-code-reference2
https://learn.microsoft.com/en-us/windows-hardware/drivers/debugger/bug-check-code-reference2


39

4. Troubleshooting tips 2-1, 2-2

2-1. Windows Update

Install the latest Windows update settings, then you can reduce the possibility that the behavior is caused 

by a bug in Windows OS. 

Install the latest BIOS drivers, then you can reduce the possibility that the behavior is caused by a bug in 

the BIOS. 

2-2. BIOS Update
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4. Troubleshooting tips 2-3

2-3. Thunderbolt Control Center related issues

Symptom Possible root cause Solution

#2-3-1

Driver Installation Failure is shown 

on Intel Gen12 CPU with Windows 

11

For Intel Gen12 CPU, Windows 11 OS already 

contains the necessary driver for Thunderbolt 

device to work properly.

No action is needed. 

Refer to Troubleshooting Tips #3-7-3.
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4. Troubleshooting tips 2-3

2-3. Thunderbolt Control Center related issues

Symptom Possible root cause Solution

#2-3-1 (for CPU Gen11 or below 

with Win11 OS & any CPU Gen 

with Win10 OS)

Thunderbolt Control Center is not 

shown from the Windows Start 

menu.

Cannot download Thunderbolt 

Software (Thunderbolt Control 

Center app) via Microsoft 

Store

Step-1: Update Thunderbolt driver

① Enter Device Manager at Windows Search

② Select Device Manager

③ Navigate to Software Components > Thunderbolt  HSA Component

④ In the Driver tab, choose Update Driver

⑤ If Thunderbolt Control Center app still cannot be installed, ask Intel to 

     support

Step-2: If the symptom still occurs, go to Error 0x803FB005 While 

Installing Thunderbolt Control Center App

③

④

①

②

https://www.intel.com/content/www/us/en/support/articles/000033223/intel-nuc.html
https://www.intel.com/content/www/us/en/support/articles/000033223/intel-nuc.html
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4. Troubleshooting tips 2-3

2-3. Thunderbolt Control Center related issues

Symptom Possible root cause Solution

#2-3-2

PCIe tunneling is Disabled

PCIe tunneling setting in BIOS 

might be incorrect.

Step-1: If you are setting up with desktop-PC, confirm the PCIe 

Thunderbolt card is installed to the appropriate slot which supports PCIe 

tunneling.

Step-2: If the symptom still occurs, go to PC BIOS setting menu and 

enable PCIe tunneling.

[samples of BIOS setting]

Dell Desktop PC BIOS (UEFI)

BIOS Setup > Integrated devices > Disable USB4 PCIE Tunneling > Off

HP Laptop PC BIOS (UEFI)

HP Computer Setup > Advanced > Thunderbolt Options > Enable 

Thunderbolt Mode
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4. Troubleshooting tips 2-4

2-4. Keysight IO Libraries Suite installation is not completed successfully

Symptom Possible root cause Solution

#2-4-1

IVI drivers and/or VISA drivers are 

not installed 

(See Proven latest versions in 

Appendix)

Old drivers are left on the system. ① Go to Shared Components (ivifoundation.org)

② Download IVI Shared Components Cleanup Utility

③ Download VISA and VISA.NET Shared  

    Components VISA Cleanup Utility

④ Execute Cleanup Utility and VISA Cleanup Utility 

     with administrator privilege

⑤ Re-boot the PC

⑥ Install the latest Keysight IO Libraries Suite with 

     administrator privilege

⑦ If the symptom still occurs, go to 

    Troubleshooting tips #1-2.

https://www.ivifoundation.org/shared_components/Default.aspx
https://www.ivifoundation.org/downloads/Shared%20Components/x86/CleanupUtility.exe
https://www.ivifoundation.org/downloads/Shared%20Components/VisaCleanupUtility_7.1.1_.exe
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4. Troubleshooting tips 2-4

2-4. Keysight IO Libraries Suite installation is not completed successfully

Symptom Possible root cause Solution

#2-4-2

.NET Framework 3.5 is not enabled

① Enter Control Panel at Windows Search

② Navigate to Programs > Programs and Features >

     Turn Windows Features on or off

③ Enable the .NET Framework 3.5

④ Re-boot the PC

For more details, go to https://docs.microsoft.com/en-

us/dotnet/framework/install/dotnet-35-windows

https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows
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4. Troubleshooting tips 2-4

2-4. Keysight IO Libraries Suite installation is not completed successfully

Symptom Possible root cause Solution

#2-4-3

Unable to get ProductCode for IO 

Libs 64 bit error is shown

Some files or registries were not removed 

correctly.

Uninstall IOLS and perform deep clean.

For more details, go to Keysight Uninstall IOLS and 

Deep Clean

https://edadocs.software.keysight.com/kkbopen/uninstall-and-deep-clean-a-malfunctioning-install-of-io-libraries-suite-682429352.html
https://edadocs.software.keysight.com/kkbopen/uninstall-and-deep-clean-a-malfunctioning-install-of-io-libraries-suite-682429352.html
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4. Troubleshooting tips 2-4

2-4. Keysight IO Libraries Suite installation is not completed successfully

Symptom Possible root cause Solution

#2-4-4

.NET Framework 3.5 is not 

installed.

• Ivi.Visa.Interop.dll is missing in 

the 32-bit VISA COM 

applications

Keysight IO Libraries Suite 2021 or later 

does not install .NET Framework.

If users want to use VISA.NET drivers 

which are provided by the IVI 

Organization rather than Keysight 

Technologies, Inc., then they must install 

.NET Framework 3.5/2.0.

The workarounds to resolve the issue is as follows:

• Install .NET Framework 3.5

• You can install .NET Framework 3.5 using the IO 

Libraries Suite installer with the net35 directive. 

For example: IOLibSuite_version.exe /s 

/z"typical;net35“

• Uninstall VISA shared component

• Repair IO Library Suite to install VISA shared 

component

Another way to fix the issue is as follows:

• Open Visual Studio developer command window 

with elevated privilege

• Change to C:\Program Files (x86)\IVI 

Foundation\VISA\VisaCom\Primary Interop 

Assemblies

• Run "IviPiaRegistration.bat"
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4. Troubleshooting tips 2-5

2-5. Keysight VNA firmware installation is not completed successfully

Symptom Possible root cause Solution

#2-5-1

KtPUsbChassis IVI drivers are not 

installed

Known issue on VNA firmware 

A.15.75.19 when no previous VNA 

firmware was installed.

Install A.15.75.22 or newer

#2-5-2

Error 1935 is shown while installing 

VNA firmware.

During the VNA firmware installation, 

required permissions are missing, or

.Net Framework setting is not correct.

① Re-boot the PC and install the latest VNA firmware 

    again.

    Make sure the VNA firmware is installed with “Run 

    as administrator” capability.

② If the symptom still occurs, disable any anti-virus, 

     anti-spyware or firewalls while installing VNA 

     firmware.

③ If the symptom still occurs, go to 

Troubleshooting tips #2-4-2.

For more details, go to 

Download Microsoft .NET Framework Repair Tool from 

Official Microsoft Download Center

④ If the symptom still occurs, go to 

    Troubleshooting tips #1-2.

https://www.microsoft.com/en-us/download/details.aspx?id=30135
https://www.microsoft.com/en-us/download/details.aspx?id=30135
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4. Troubleshooting tips 2-5

2-5. Keysight VNA firmware installation is not completed successfully

Symptom Possible root cause Solution

#2-5-3

Error 1720 is shown while installing 

VNA firmware

There is a problem with Windows 

Installer Package.

Go to Error 1720:There is a problem with this 

Windows Installer package. A - Microsoft Community

If the symptom still occurs, go to 

Troubleshooting tips #1-2.

https://answers.microsoft.com/en-us/windows/forum/all/error-1720there-is-a-problem-with-this-windows/67dc78d1-0937-4eac-a1d6-9e738551fc3c
https://answers.microsoft.com/en-us/windows/forum/all/error-1720there-is-a-problem-with-this-windows/67dc78d1-0937-4eac-a1d6-9e738551fc3c
https://answers.microsoft.com/en-us/windows/forum/all/error-1720there-is-a-problem-with-this-windows/67dc78d1-0937-4eac-a1d6-9e738551fc3c
https://answers.microsoft.com/en-us/windows/forum/all/error-1720there-is-a-problem-with-this-windows/67dc78d1-0937-4eac-a1d6-9e738551fc3c
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4. Troubleshooting tips 2-6

2-6. Keysight License Manager installation is not completed successfully

Symptom Possible root cause Solution

#2-6-1

Keysight License Service  is 

installed but not running on the 

host PC

Agilent License Service/ Keysight License 

Service Stopped.

Change Agilent License Service/ Keysight License 

Service status from Stop to Running 

For more details, go to FAQ in Keysight.com.

#2-6-2

License Service not installed

Old VNA firmware installer didn’t handle 

Keysight License service well

The 89600 VSA firmware installer enables user to 

manually install the required Keysight Licensing 

Service.

For more details, go to FAQ in Keysight.com.

#2-6-3

VNA firmware shows “Error 

Initializing licensing provider. File 

Keysight.Ccl.Licensing.App.dll 

does not appear to be signed with 

a valid digital signature”

Missing “DigiCert Assured ID Root CA” ① Download “DigiCert Assured ID Root CA 

Serial Number:   

0CE7E0E517D846FE8FE560FC1BF03039”  from    

DigiCert Root Certificates - Download & Test | 

DigiCert.com

② Enter Manage User Certificates at Windows Search

③ Select Manage User Certificates

④ Install the certificate under Certificates – Current 

User\Trusted Root Certification Authorities\Certificates\ 

https://edadocs.software.keysight.com/kkbopen/the-keysight-license-service-is-installed-but-not-running-on-this-computer-what-to-do-730872069.html?
https://edadocs.software.keysight.com/kkbopen/license-service-not-installed-688425100.html
https://www.digicert.com/kb/digicert-root-certificates.htm#roots
https://www.digicert.com/kb/digicert-root-certificates.htm#roots
https://www.digicert.com/kb/digicert-root-certificates.htm#roots
https://www.digicert.com/kb/digicert-root-certificates.htm#roots
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4. Troubleshooting tips 3-1

3-1. USB-C cable is connected wrongly 

Symptom Possible root cause Solution

#3-1

Thunderbolt device functionality 

might be limited is shown in 

Device Manager

USB-C cable is connected between 

Streamline B model and PC

Replace USB-C cable with the Thunderbolt 3 cable 

included in the Streamline Series VNA
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4. Troubleshooting tips 3-3

3-3-1. Power LED does not turn green

Symptom Possible root cause Solution

#3-3-1-1

Not glowing amber when power 

adapter is connected to VNA

Power adapter or

power line in the VNA is broken.

Return it to Keysight for repair

#3-3-1-2

Blinking red

Power adapter does not supply enough 

power

① Check if proper power adapter is used (See 3-2).

     If KPN 0950-6128 is used to Streamline Series 

    VNA 4-/6- port model, replace it with KPN 0950-6166.

② Retry powering on the VNA.

     If the symptom still occurs, return it to Keysight for repair.

#3-3-1-3

Glowing red

PC does not recognize the VNA ① Check the power on sequence.

1.Connect the cable between PC and the VNA (See 3-1)

2. Power on the VNA (See 3-2, 3-3)

3. Power on the PC (3-4)

② If the symptom still occurs, return it to Keysight for repair.

Power LED
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4. Troubleshooting tips 3-3

3-3-1. Power LED does not turn green

Symptom Possible root cause Solution

#3-3-1-4

Once glowing green for a few 

seconds, then shutdown 

automatically

Impacted model: 2-port VNA only

VNA firmware version A.15.60.05 or 

newer has a function to shutdown  

automatically when in-rush voltage drop 

event is detected. [This is intended 

behavior]

① Check if VNA firmware version A.15.55.14 or 

     newer.

     If VNA firmware version is A.15.60.05 or newer, 

     the firmware has a function to shutdown 

     automatically when in-rush voltage drop event is 

     detected. 

② Retry powering on the VNA.

     If the symptom still occurs, return it to Keysight 

     for repair.

#3-3-1-5

Glowing blue

Chassis FPGA update failed. Return it to Keysight for repair

[Power LED status]

Refer to https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm

Power LED

https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm
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4. Troubleshooting tips 3-3

3-3-1. Power LED does not turn green

Symptom Possible root cause Solution

#3-3-1-6

VNA chassis power button LED 

turned from Green to Red when 

USB/Thunderbolt cable is 

connected.

VNA firmware is equipped with current 

surge detection function to shutdown 

automatically when surge is detected. 

[This is intended behavior].

Abrupt surge (transient) during power on 

stage lead to the false alarm and the 

chassis is automatically switched off. 

① Update VNA firmware to version A.16.70.00 or    

newer. VNA chassis IVI-C and IVI.NET driver 

version 1.1.10 and above resolve the false 

alarm.

② Retry powering on the VNA.

     If the symptom still occurs, return it to Keysight 

     for repair.

[Power LED status]

Refer to https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm

Power LED

https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm
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4. Troubleshooting tips 3-3

3-3-2. Instrument Status LED does not turn Green

Symptom Possible root cause Solution

#3-3-2-1

Glowing amber

Power is ON, but firmware is not running. ① Check if VNA firmware is working correctly.

② If not, go to Troubleshooting tips2-5

③ Check if the cable between Streamline Series 

     VNA and PC is connected correctly

④ If not, replace the cable

⑤ If the symptom still occurs, return it to Keysight 

     for repair.

#3-3-2-2

Glowing red

PC battery is not maintained in a fully 

charged condition. 

Or

A hardware error has occurred, or the 

VNA firmware is not installed or corrupted 

in the PC.

① Make sure AC/DC adapter for the PC is connected.

② Check if VNA firmware is installed correctly.

③ If not, go to Troubleshooting tips 2-5

④ If the symptom still occurs, check if Keysight IO 

     Libraries Suites is installed correctly.

⑤ If not, go to Troubleshooting tips 2-4

⑥ If the symptom still occurs, return it to Keysight 

     for repair.

[Instrument Status LED status] 

Refer to https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm

Instrument Status LED

https://helpfiles.keysight.com/csg/pxivna/Front_Panel/P937xA_Front_Panel.htm
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4. Troubleshooting tips 3-5

3-5. Device Licenses Changed dialog is not shown

Symptom Possible root cause Solution

#3-5-1

Device Licenses Changed dialog is 

not shown

#1 Notifications for Keysight License 

Notifier turns off

① Enter Notification at Windows Search

② Select Notifications & actions settings

③ Turn on Keysight License Notifier

②

①

③
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4. Troubleshooting tips 3-5

3-5. Device Licenses Changed dialog is not shown

Symptom Possible root cause Solution

#3-5-1

Device Licenses Changed dialog is 

not shown

#2. Agilent License Service/ Keysight 

License Service is not running

① Enter Services at Windows Search

② Select Services

③ If Status of Agilent License Service/ Keysight 

License Service is blank, open 

     Agilent License Service/ Keysight License Service 

Properties

④ Select Start 

⑤ Select OK

④

⑤

②

①

③
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4. Troubleshooting tips 3-6
3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-1

For B model with 2 modules, one of 

two VNA modules is not correctly 

recognized in some PCs as shown 

with Code 12 error in Device 

Manager.

PC cannot allocate enough free Kernel 

memory resource for PCIe 

To solve this issue, registry edit is required with

TH_PCIE.zip

Note: 

1. The following steps are to be performed at end 

user’s own risk.

2. This solution of Code12 error is for Streamline B 

model with 2 modules only. 

This solution cannot be applied to Code 12 error of A 

model and of B model with 1 module.

TH_PCIE.zip

https://www.keysight.com/my/en/assets/9922-02069/miscellaneous/TH-PCIE.zip
https://www.keysight.com/my/en/assets/9922-02069/miscellaneous/TH-PCIE.zip
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-1 Step-1: Backup the current registry and check the current registry values

Launch Registry Editor:

① Enter registry editor at Windows Search

② Select Registry Editor

③ Navigate to File> Export

④ Select All for Export Range

⑤ Enter file name (example original_reg_ddmmyyyy.reg)  

⑥ Select Save

⑦ Check the current value before registry patch at \HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PnP\Pci

Step-2: Download and unzip the TH_PCIE.reg registry patch to the PC the VNA is connected to. 

②

① ④

⑤

③

⑥

⑦

TH_PCIE.zip

https://www.keysight.com/my/en/assets/9922-02069/miscellaneous/TH-PCIE.zip
https://www.keysight.com/my/en/assets/9922-02069/miscellaneous/TH-PCIE.zip
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-1 Step-3: Edit registry

Launch Registry Editor with administrator privilege:

① Enter registry editor at Windows Search

② Execute Registry Editor with administrator privilege

③ Navigate to File> Import

④ Select TH_PCIE.reg

⑤ Select Open 

⑥ Select OK

Tips: Alternative procedure for step ① to ⑥, double click on the registry patch to add.

②

①

③ ④

⑤

⑥
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-1 Step-4: Ensure the HackFlags value is successfully edited to \HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\

Control\PnP\Pci

After registry patch

Before registry patch



61

4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-2

For A model with 1 module and B 

model with 1 module, Code 12 

error is shown in Device Manager

PC cannot allocate enough free Kernel 

memory resource for PCIe 

Use another PC in Thunderbolt PC and Streamline 

Series VNA B model compatibility list

#3-6-3

For 2 VNA operation with star 

topology or with daisy topology, 

Code 12 error is shown in Device 

Manager

PC cannot allocate enough free Kernel 

memory resource for PCIe 

Go to Troubleshooting Tips #3-6-1
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-4

For B model, Code 55 error is 

shown in Device Manager

B model is blocked from 

enumeration, due to a Group 

policy / MDM policy to protect 

from DMA attack.

① This issue can be resolved with Microsoft service pack 

update KB5014699 for Windows 10 versions 20H2 and newer. 

Install Windows 10 versions 20H2 or newer.

② If you need to stay on older versions of Windows 10 prior to 

20H2, the workaround is to disable the Kernel DMA Protection 

in the BIOS setting. To disable Bitlocker and Windows Kernel 

DMA Protection, it depends on different manufacturer BIOS.

  You may also set Intel Virtualization Technology for I/O (VT-d) 

to Disabled in the BIOS, if Kernel DMA Protection cannot be 

disabled.

  Below is a sample of HP PC BIOS setting.

③ If the symptom still occurs, contact end user’s IT 

department to change the Group Policy / MDM policy to 

protect from DMA attack.

https://support.microsoft.com/en-us/topic/june-14-2022-kb5014699-os-builds-19042-1766-19043-1766-and-19044-1766-5c81d49d-0b6e-4808-9485-1f54e5d1bb15
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-5

Keysight VNA icon is not shown

This is not an issue. No action is required.

#3-6-6

No VNA device(s) is/are shown 

under Keysight Technologies 

Modular Devices, but VNA 

device(s) is/are shown under Other 

devices

Windows does not recognize VNA 

device(s) correctly, since P50xx drivers 

are not installed correctly.

[Known Issue on A15.75.19 for Streamline 

Series VNA (P50xxA/B, P93xxA/B)]: The 

unit will not be detected if you install the 

firmware from scratch. The driver for 

Chassis is not installed at this version.

Go to Troubleshooting Tips #2-5-1
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-7

P600X Chassis is not shown under 

Keysight Technologies Modular 

Devices, but P600X Chassis is 

shown under Other devices. Code 

28 error is shown in Device 

Manger.

#1. Chassis drivers are missing or broken

#2. Thunderbolt Control Center does not 

recognize P600X Chassis

#1. Go to Troubleshooting tips 2-5

#2. Go to Troubleshooting tips 3-7
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4. Troubleshooting tips 3-6
3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Symptom Possible root cause Solution

#3-6-8

For B models, Thunderbolt control 

center detects and recognizes the 

instrument correctly. 

In Device Manager, the B model is 

not correctly recognized. 

Under “System Devices” > PCI 

Express Upstream/ Downstream 

Port shows Code31 error. 

Operating System runs out of PCI bus 

numbers. Typically, the computer BIOS 

configures a limited bus-number range for 

PCI Express bridge device When an 

expansion chassis that contains a PCI 

Express complex switch together with a 

deep device hierarchy is added to the 

computer, the OS runs out of available 

bus numbers. Therefore, the system 

cannot start devices in the expansion 

chassis. 

Fail to attach PCI Express expansion 

chassis - Windows Client | Microsoft 

Learn

To solve this issue, perform the following:

This requires two-stage solutions:

First, remove Code31 error.

Secondly, remove Code12 error. (Code12 may appear 

after Code31 is resolved) 

Note: 

1. The listed steps are to be performed at end user’s 

own risk.

https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-8 Step-1: Backup the current registry and check the current registry values

Launch Registry Editor:

① Enter registry editor at Windows Search

② Select Registry Editor

③ Navigate to File> Export

④ Select All for Export Range

⑤ Enter file name (example original_reg_ddmmyyyy.reg)  

⑥ Select Save

⑦ Check the current value before registry patch at \HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PnP\Pci

②

① ④

⑤

③

⑥

⑦
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-8 Group1: Intel PCI Express Root Port. (Description starts with Intel)

Group2: PCI Express Downstream/ Upstream Switch Port. 

Step-2: In Device Manager, under “System Devices”, identify the PCI Express item (Group2) with Code31 ! warning status. 

Disable it.  
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-8 Group1: Intel PCI Express Root Port. (Description starts with Intel)

Group2: PCI Express Downstream/ Upstream Switch Port. 

Step-3: Apply registry hack flags of 200 (Hex). Restart PC.

Fail to attach PCI Express expansion chassis - Windows Client | Microsoft Learn

https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
https://learn.microsoft.com/en-us/troubleshoot/windows-client/setup-upgrade-and-drivers/error-attach-pci-express-expansion-chassis
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4. Troubleshooting tips 3-6

3-6. one P600X Chassis device and one or two VNA device(s) are not shown correctly

Solution (cont.)

#3-6-8 Group1: Intel PCI Express Root Port. (Description starts with Intel)

Group2: PCI Express Downstream/ Upstream Switch Port. 

Step-4: Disable some of the Intel® PCI Express Root Port (Group1). 

Step-5: Re-enable the PCI Express Upstream Switch Port (Group2) until P50xxB appears in Device Manager.

Note: At this stage, if B model remains undetected, repeat step-4 for every single Intel PCI Express Root Port (Group1) 

followed with step-5. 

If the B model appears in Keysight Technologies Modular Devices group with Code 12 error, proceed with Step-6. Otherwise, 

proceed with step-7.

Step-6: Disable even more Intel PCI Express Root Port (Group1) until the B model appears correctly without Code 12. 

Step-7: Once it is correctly recognised, re-enable the devices previously disabled in Device Manager (Group1 & Group2)
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4. Troubleshooting tips 3-7

3-7. one P600X is not connected in Attached Thunderbolt  device [for Streamline Series VNA B model only]

Symptom Possible root cause Solution

#3-7-1

P600X is not shown

Chassis drivers are missing or broken Go to Troubleshooting tips 2-5

#3-7-2

P600X is shown, but is not 

connected

Old version of Thunderbolt Control Center 

app requests user to approve to connect 

P600X as Thunderbolt device

① Enter Thunderbolt at Windows Search

② Select Thunderbolt Control Center

③ Select hamburger menu

④ Select Approve devices

⑤ Select Keysight Technologies, P600X

⑥ Select Always connect

⑤
⑥

③

④②

①
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4. Troubleshooting tips 3-7

3-7. one P600X is not connected in Attached Thunderbolt  device [for Streamline Series VNA B model only]

Solution (Cont.)

#3-7-2 To pre-approve Thunderbolt device connection for every device

① Re-boot into BIOS (UEFI) settings

② Select “PCIe and Display Port – No Security” in Thunderbolt Options 

③ Save changes and restart the PC

Below are the HP BIOS settings samples.
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4. Troubleshooting tips 3-7

3-7. one P600X is not connected in Attached Thunderbolt  device [for Streamline Series VNA B model only]

Symptom Possible root cause Solution

#3-7-3

P600X is not shown in Thunderbolt 

Control Center application on PC 

of Windows 11 OS .

P50xxB/P93xxB is connected to PC of 

Gen12 or later CPU with Windows 11 OS 

through USB4 connection manager.

This is not an issue on PC of Gen12 or later CPU with 

Windows 11 OS, when Keysight Connection Expert 

shows the required devices. 

No action is required.

Introduction to the USB4 connection manager in 

Windows | Microsoft Learn

https://learn.microsoft.com/en-us/windows-hardware/design/component-guidelines/usb4-intro-to-connection-manager
https://learn.microsoft.com/en-us/windows-hardware/design/component-guidelines/usb4-intro-to-connection-manager
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4. Troubleshooting tips 3-8

3-8. One chassis and one or two VNA device(s) are not shown in Keysight Connection Expert

Symptom Possible root cause Solution

#3-8-1

P6001A,P6002A,P6005A or 

P6006A  is not shown

Chassis drivers are missing or broken Go to Troubleshooting tips 2-5

#3-8-2

P50xxA, P93xxA, P50xxB, P93xxB 

is not shown

#1. Instrument drivers are missing or 

broken.

#2. IVI drivers are missing or broken or

#3. PC cannot allocate enough free 

Kernel memory resource for PCIe

#1. Go to Troubleshooting tips 2-5

#2. Go to Troubleshooting tips 2-4

#3. Go to Troubleshooting tips #3-6-1 for Streamline 

      Series VNA B model with 2 modules
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4. Troubleshooting tips 3-8

3-8. One chassis and one or two VNA device(s) are not shown in Keysight Connection Expert

Symptom Possible root cause Solution

#3-8-3

P6001A or P6002A is shown under 

PXI (PXI0)

Launch Keysight Connection Expert

① Click PXI/AXIe Chassis

② Select P6001A or P6002A

③ Click Delete Chassis

④ Close Keysight Connection Expert and 

     re-boot the PC

#3-8-4

P6005A or P6006A is shown under 

PXI (PXI10)

Device Manager cannot recognize PXI 

Chassis

Launch Keysight Connection Expert

① Click PXI/AXIe Chassis

② Select P6005A or P6006A

③ Click Delete Chassis

④ Close Keysight Connection Expert and 

     re-boot the PC

①
②

③
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4. Troubleshooting tips 3-8

3-8. One chassis and one or two VNA device(s) are not shown in Keysight Connection Expert

Symptom Possible root cause Solution

#3-8-5

P50xxA, P93xxA is shown under 

PXI (PXI0)

#3-8-6

P50xxB,P93xxB is shown under 

PXI (PXI10)
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4. Troubleshooting tips 3-9

3-9. required license is not shown in Keysight License Manager

Symptom Possible root cause Solution

#3-9-1

No license is shown

Agilent License Service/ Keysight License 

Service stopped

Go to Troubleshooting tips #3-5

#3-9-2

A certain license is missing

① Go to http://www.keysight.com/find/softwaremanager
② Enter Order Number and Certificate Number of your 

    Streamline Series VNA

③ Select Find Certificate

④ Get the license

⑤ Install the license

#3-9-3

“The Agilent License Service was 

unable to start. The licensing host 

ID is invalid ….” error message is 

shown

Go to Troubleshooting tips #1-2 Step-3

http://www.keysight.com/find/softwaremanager
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4. Troubleshooting tips 3-9

3-9. required license is not shown in Keysight License Manager

Symptom Possible root cause Solution

#3-9-4

The licensing host ID is invalid.

Go to Troubleshooting tips #1-2 Step-3
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-1

Fail to read FPGA of Pxxxxx 

(chassis x, slot x) is shown while 

Initializing hardware.

VNA firmware was not able to read FPGA 

on Analog Module

Go to Troubleshooting Tips #3-10-4
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-2

Invalid correction data in Flash 

memory (Module1) is shown while 

loading factory cal data.

Factory calibration data is corrupted. Return it to Keysight for calibration
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-3

VNA firmware halts at “Loading 

Calset”  

Combination issue between VNA firmware 

and HPP5.3

Install VNA firmware A.15.75.22 or newer
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-4

“Unable to program FPGA image. 

Application will now close” 

message is shown, while updating 

VNA FPGA.

When FPGA image in VNA is different 

from the one in VNA firmware, VNA 

firmware attempts to load the FPGA 

image to VNA chassis. During this 

process, a time out error may occur.

The root cause of this issue is due to 

declined Thunderbolt signal quality on 

PCIe Thunderbolt card for Desktop PC or 

Thunderbolt cable.

Step-1:

① Install VNA firmware A.19.30.21 or newer

② Launch Network Analyzer (See 3-10)
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (Cont.)

#3-10-4 Step-1:

③ FPGA Programming Status pops up, then click Yes

④ FPGA Programming Status pops up and click OK, then launch Network Analyzer (See 3-10).

⑤ The following message pops up, then click OK

                                                                                                            

                                                               

⑥ Launch Network Analyzer (See 3-10), again

③ ④ ⑤
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (Cont.)

#3-10-4 Step-2: If the symptom still occurs, follow the steps from ① to ⑩ as IO monitor workaround

① Open Keysight Connection Expert as administrator 

② Click Instrument and click IO Monitor

③ Select Tools and Settings…
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (Cont.)

#3-10-4 Step-2:

④ Check every single IO log capture source and click OK

⑤ Click Start Capturing Message in IO Monitor

⑥ Launch Network Analyzer (See 3-10)

    Note that the message are captured in Keysight IO Monitor
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (Cont.)

#3-10-4 Step-2:

⑦ FPGA Programming Status pops up, then click Yes

⑧ FPGA Programming Status pops up and click OK, then launch Network Analyzer (See 3-10).

⑨ The following message pops up, then click OK

                                                                                                            

                                                               

⑩ Launch Network Analyzer (See 3-10), again

③
④ ⑤
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (Cont.)

#3-10-4 Step-3: If the symptom still occurs, go to Troubleshooting tips #3-3-2 to check status LED

Step-4: If the symptom still occurs, check if the Thunderbolt PCIe Hot plug Mode in BIOS (UEFI) setting is Legacy Mode.

            ① Re-boot into BIOS (UEFI) settings.

            ② If Thunderbolt PCIe Hot plug mode is “Legacy Mode”, change it to “Native + Low Power Mode”.

  Below is the HP BIOS settings sample.

Step-5: If the above BIOS setting does not exit and the symptom still occurs, try the followings.

• Use known-good cable

• Use another known-good laptop PC

• Use PCIe Thunderbolt card for desktop PC which the desktop PC maker recommends
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-5

“Self test failure: Sweep timeout” 

error message is shown

Interconnect cables for LO or control 

cable is not connected properly or broken.

① Check if the control cable (Black) is connected properly.

If the connection is missing or loosened, connect it and 

tighten it with the nuts as shown in the image below.

② If the symptom still occurs, replace the control cable.

[2 VNA multiport connection] 

Refer to https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multiport_and_Multisite_Configuration.htm#P937xA_Multiport_VNA

1 VNA operation 

of Streamline Series VNA A 

model with 2 modules or

of Streamline Series VNA B 

model with 2 modules

2 VNA operation 

control cable

nuts

https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multiport_and_Multisite_Configuration.htm#P937xA_Multiport_VNA
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-5

“Self test failure: Sweep timeout” 

error message is shown

Incorrectly configured chassis number for 

primary and secondary chassis in 

Connection Expert/ IOLS.

① Check if the control cable is connected in the correct 

direction. To configure a unit into a primary chassis, it 

needs to be assigned with a lower chassis# in IOLS than 

secondary chassis.

Primary chassis will always output Ctrl-M and LO-out 

signal into secondary chassis Ctrl-S and LO-in. 

[2 VNA multiport connection] 

Refer to

https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multipor

t_and_Multisite_Configuration.htm#P937xA_Multiport_VN

A

Note: In the multiport configuration using 2 modules, it is 

critical that the correct chassis number be assigned to the 

“primary" chassis. The primary chassis must have the 

lowest chassis number.

https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multiport_and_Multisite_Configuration.htm#P937xA_Multiport_VNA
https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multiport_and_Multisite_Configuration.htm#P937xA_Multiport_VNA
https://helpfiles.keysight.com/csg/pxivna/S0_Start/Multiport_and_Multisite_Configuration.htm#P937xA_Multiport_VNA
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-6

[Streamline Series VNA B model 

only]

Hot plug-in/out1 of VNA is not 

working correctly on non-English 

(Traditional Chinese and Simplified 

Chinese) OS. 

PC re-boot is required to recognize 

the VNA after hot plug-in.

Note: 

1. Hot plug-in/out is a function that 

PC can recognize Thunderbolt 

device while connecting or 

disconnecting Thunderbolt cable 

without re-booting the PC.

KtPUsbChassis IVI.NET driver 1.1.8 and 

KtPUsbChassis IVI-C driver 1.1.8 cannot 

handle non-English code properly.

Install VNA firmware A.15.75.22 or newer
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-7

[Streamline Series VNA B model 

only]

When user tries to access 

Streamline B model remotely via 

Remote Desktop (remote logon 

after controller PC reboot), 

Streamline B model cannot be 

recognized until user manually 

logon the controller PC with 

physical keyboard. 

Windows Kernel DMA Protection blocks 

an external access to Thunderbolt device.

When Kernel DMA Protection is enabled:

Peripherals with DMA Remapping-

compatible device drivers are 

automatically enumerated and started

Peripherals with DMA Remapping-

incompatible drivers are blocked from 

starting if the peripheral was plugged in 

before an authorized user logs in, or while 

the screen is locked. Once the system is 

unlocked, the peripheral driver is started 

by the OS, and the peripheral continues to 

function normally until the system is 

rebooted, or the peripheral is unplugged. 

The peripheral will continue to function 

normally if the user locks the screen or 

signs out of the system. Kernel DMA 

Protection | Microsoft Learn

Solution 1: Disable Kernel DMA Protection.

For more information on how this works and how to 

prevent it, refer to the following document from 

Microsoft and configure it appropriately 

https://docs.microsoft.com/en-

us/windows/security/information-protection/kernel-

dma-protection-for-thunderbolt 

Solution 2: Enable auto-logon to Windows. 

If user intends to enable the Kernel DMA Protection 

function, configure the controller PC to enable auto-

logon upon reboot. 

For more information on how this works, refer to the 

following document from Microsoft and configure it 

appropriately. 

https://learn.microsoft.com/en-

us/sysinternals/downloads/autologon

https://learn.microsoft.com/en-us/windows/security/hardware-security/kernel-dma-protection-for-thunderbolt
https://learn.microsoft.com/en-us/windows/security/hardware-security/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt
https://learn.microsoft.com/en-us/sysinternals/downloads/autologon
https://learn.microsoft.com/en-us/sysinternals/downloads/autologon
https://learn.microsoft.com/en-us/sysinternals/downloads/autologon
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-8

[Streamline Series VNA B model 

only]

When PC is resumed, Streamline 

B model cannot be recognized.

Fast Startup disconnects Thunderbolt 

device.

Disable Fast Startup.

① Enter powercfg.cpl at Windows Search

② Execute powercfg.cpl with administrator privilege 

③ Select “Choose what the power buttons do” from the 

     menu on left.

④ Uncheck the box of “Turn on fast startup”.

⑤ If these options are greyed out, then select “Change 

     settings that are currently unavailable” and go to ④
     again

③

④

①

②

⑤
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-9

VNA shuts down intermittently, 

after running for an extended 

period of time. Sometimes error 

like “Self test failure: Module test 

Pxxxx (Chassis x, Slot x) is shown

One of possible cause is overheating. Remove dust and air blockage from around the VNA, 

increase airflow however possible

[Streamline Series VNA A model only] 

Another possible cause is Windows 

power settings interfering with VNA 

operation

Disable automatic USB shutoff in Windows

① Enter Edit power plan at Windows Search

② Select Edit power plan

③ Select Change advanced power settings

④ Navigate to USB settings > USB selective suspend 

     setting and turn this Disabled:

①

②

③

④
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①

②

4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (cont.)

#3-10-9 Disable automatic USB shutoff in Windows.

① Enter Computer Management at Windows Search

② Execute Computer Management with administrator privilege

③ Navigate to Device Manager > View > Devices by connection

④ Navigate to ACPI x64-based PC > Microsoft ACPI-Compliant System > PCI Express Root Complex > Intel® USB 3.10 

     eXtensible Host Controller – 1.20 (Microsoft) > the Keysight devices labelled "P50xx USB VNA" and "P600X Chassis“

⑤ Select the USB Root hub one level above these items and open Properties

⑥ Uncheck “Allow the computer to turn off this device to save power” in the Power Management tab 

③

④

⑤

⑥
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Solution (cont.)

#3-10-9 If the symptom still occurs, return it to Keysight for repair.
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-10

DSP Execution Error is shown

When DSP cannot receive the whole 

measurement data within the specified 

time, this error message is shown.

There are some root causes found.

#1. Command list size is bigger than 

FPGA processing capability

#2. Contact failure due to

• PCIe connector lubricant

• control cable connector contamination

• control cable physical stress.

• solder residual on backplane board

• flux residual on backplane board

Step1: Check if control cable is connected properly.

Go to Troubleshooting tips #3-10-5.

Step2: If the symptom still occurs, try Workaround for 

#1. 

Workaround for #1

If user measures multiple sweeps per channel, VNA 

firmware sends one command list per channel.

Keysight workaround proposal is to send one 

command per sweep. Ask Keysight for more details.

Step3: If the symptom occurs continuously, return it to 

Keysight for repair.
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-11

DLL & COM error is shown.

Microsoft Visual C++ 2015-2019 versions 

are missing or corrupted.

Download and install x64 for Visual C++ 

2015/2017/2019 from Latest supported Visual C++ 

Redistributable downloads | Microsoft Learn

Refer to VCRUNTIME140_1.dll Missing: where to get? 

- Microsoft Community

https://aka.ms/vs/17/release/vc_redist.x64.exe
https://aka.ms/vs/17/release/vc_redist.x64.exe
https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
https://answers.microsoft.com/en-us/windows/forum/all/vcruntime1401dll-missing-where-to-get/268964c7-6910-4cdd-9a96-b03f4c1f6954
https://answers.microsoft.com/en-us/windows/forum/all/vcruntime1401dll-missing-where-to-get/268964c7-6910-4cdd-9a96-b03f4c1f6954
https://answers.microsoft.com/en-us/windows/forum/all/vcruntime1401dll-missing-where-to-get/268964c7-6910-4cdd-9a96-b03f4c1f6954
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-12

FW does not recognize “S97824xB 

Vector network analyzer activation 

software” Update necessary 

license pop-up is shown.

FW bug to check the required license Install VNA firmware A.15.60.05 or newer
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-13

FW does not recognize -2xx,-4xx 

or -6xx license. Update necessary 

license pop-up is shown.

KLM license is expired Check the license in Keysight License Manager

Update necessary license, if the license is expired.
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-14

Invalid source port name error is 

shown.

VNA firmware detects a different number 

of physical source ports than the installed 

option

① Uninstall VNA firmware and delete the below 

     folders.

     C:\ProgramData\Keysight\Network Analyzer

     C:\Program Files\Keysight\Network Analyzer

     C:\Users\Public\Public Documents\Network Analyzer

② Install the latest VNA firmware again
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-15

The trigger operation failed. 

Application will now close error is 

shown.

Interconnect cables for LO or control 

cable is not connected properly or broken.

Go to Troubleshooting tips #3-10-5 
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-16

Option 551 ‘N-port capability’ is 

required error is shown.

S97551B-1FP license is not loaded to 

Keysight License Manager.

Go to Troubleshooting tips #3-9-2
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-17

During USB Chassis FPGA 

Update, “Failed to retrieve model 

number from VNAParser.exe, 

application will exit.” error and 

“VNA Parser has encountered a 

problem ….” error are shown.

SCPII parser is crashed during VNA FW 

installation.

Go to Troubleshooting Tips#3-10-4 Step-2.
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4. Troubleshooting tips 3-10

3-10. VNA firmware halts or shows error message

Symptom Possible root cause Solution

#3-10-18

Other VNA firmware installation 

issue

Further investigation is required to solve the VNA 

firmware installation issue.

① Download the diagnostic tool 

(VNA_Install_Check.exe) from 

https://files.keysight.com/dl/IjMqqBP1rm 

② Launch the diagnostic tool

③ If you see Failure!, copy the Diagnostic Output and 

send it to Keysight.

https://files.keysight.com/dl/IjMqqBP1rm
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4. Troubleshooting tips 3-11

3-11. Remote communication does not work well

Symptom Possible root cause Solution

#3-11-1

Device Licenses Changed dialog is 

not shown.

Agilent License Service is not working Go to Troubleshooting tips #3-5-1

#3-11-2

*IDN? shows ! 

VI_ERROR_NSUP_OPER: 

Operation not supported Visa 

ErrorCode: 0xBFFF0067 (-

1073807257)

Remote Interface is not set up correctly Go to 3-11. Communicate remotely using LAN 

(TCPIP) 
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▪ Thunderbolt PC and Streamline Series VNA B model compatibility list

▪ PC makers’ driver download page

▪ Proven latest versions

▪ VNA firmware revision history

▪ Contact Keysight – Issue sharing

Appendix



106

Thunderbolt 3 PC and Streamline Series VNA B model compatibility list
PCs with Thunderbolt 3 interface in the list are verified to work with P50xxB/P93xxB VNAs

Note:

1. 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

2. 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

3. Two VNA operation with star topology requires two Thunderbolt ports on a single PC. This topology is not available with a PC with a single Thunderbolt port.

4. Two VNA operation with daisy topology requires only one Thunderbolt port on a single PC. This topology is available with a PC with a single Thunderbolt port.

5. If PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

6. Thunderbolt Controller chipset driver was copied from Zbook 15 G5.

PC Maker PC model name CPU Gen - Code name CPU OS                                                Microsoft Windows BIOS

Thunderbolt 

Controller 

(chipset) 

Gen

# of 

Thunderbolt3 

connectors

Single VNA 

operation 

(1module 

model)1

Single VNA 

operation 

(2modules 

model)2

Two VNA 

operation 

(star 

topology3)

Two VNA 

operation 

(daisy 

topology4)

Verified by

Laptop/Mobile workstation

Dell Latitude 7410 10
th

 Gen - Comet Lake Intel Core i7-10810U Windows 10 Business (x64) 1.19.0, 11/7/2022 15EB 2 Pass Pass Pass Pass end user

Dell Precision 5530 8
th

 Gen - Coffee Lake Intel Core i7-8850H Windows 11 Professional (x64) 1.31.0, 3/13/2023 15D9 1 Pass Pass N/A Pass Keysight

Dell Precision 5540 9
th

 Gen - Coffee Lake Intel Xeon E-2276M Windows 10 Professional (x64) 1.23.0, 7/18/2023 unknown 1 Pass Pass N/A Pass end user

Dell Precision 5550 10
th

 Gen - Comet Lake Intel Core i7-10750H Windows 10 Professional (x64) 1.6.1, 1/14/2021 15EB 2 Pass Pass Pass Pass Keysight

Dell Precision 7550 10
th

 Gen - Comet Lake Intel Core i7-10850H Windows 10 Professional (x64) 1.22.0, 3/21/2023 15EB 2 Pass Pass Pass Pass Keysight

Dell XPS 15 9560 7
th

 Gen - Kaby Lake Intel Core i7-7700HQ Windows 10 Professional (x64) 1.22.1, 3/24/2021 unknown 1 Pass not tested N/A not tested end user

HP EliteBook 830 G6 8
th

 Gen – Whiskey Lake Intel Core i5-8365U Windows 10 Professional (x64) R70 Ver 01.12.20 15EB 1 Pass not tested N/A not tested end user

HP EliteBook 830 G7 10
th

 Gen - Comet Lake Intel Core i5-10210U Windows 10 Professional (x64) unknown 15EB 2 Fail not tested not tested not tested end user

HP EliteBook 840 G5 8
th

 Gen - Coffee Lake Intel Core i5-8350U Windows 10 Enterprise (x64) unknown 15E8 1 Pass not tested not tested not tested end user

HP EliteBook 840 G6 8
th

 Gen – Whiskey Lake Intel Core i5-8365U Windows 10 Professional (x64) R70 Ver.01.20.00, 5/10/2022 15E8 1 Pass Pass N/A Fail end user

HP EliteBook 840 G7 10
th

 Gen - Comet Lake Intel Core i5-10310U Windows 10 Professional (x64) S70 Ver.01.09.00, 5/10/2022 15EB 1 Pass Pass
5 N/A Pass Keysight

HP ZBook 15 G4 7
th

 Gen - Kaby Lake Intel Core i7-7028HQ Windows 10 Professional (x64) P70 Ver.01.41, 4/29/2022 15EB 
6 2 Pass not tested not tested not tested end user

HP ZBook 15 G5 8
th

 Gen - Coffee Lake Intel Core i7-8850H Windows 10 Professional (x64) Q70 Ver 01.19.00, 1/27/2022 15EB 2 Pass Pass Pass not tested end user

HP ZBook 15 G6 9
th

 Gen - Coffee Lake Intel Core i9-9880H Windows 10 Professional (x64) R92 Ver 01.23.00, 11/29/2022 15EB 2 Pass Pass Pass Pass Keysight

HP Zbook Power G7 10
th

 Gen - Comet Lake Intel Core i7-10850H Windows 10 Enterprise (x64) T75 Ver 01.12.00, 3/1/2023 15EB 1 Pass Pass N/A Pass Keysight

HP ZBook Studio G7 10
th

 Gen - Comet Lake Intel Core i7-10750H Windows 10 Professional (x64) S91 Ver.01.90.00, 5/10/2022 15EB 2 Pass Pass Pass Pass Keysight

HP ZBook Firefly 14 G7 10
th

 Gen - Comet Lake Intel Core i7-10810U Windows 10 Professional (x64) S70 Ver.01.03.02, 4/11/2020 15EB 2 Pass Pass Pass Pass Keysight

HP ZBook Firefly 14 G7 10
th

 Gen - Comet Lake Intel Core i7-10810U Windows 10 Professional (x64) S70 Ver.01.12.00, 4/1/2023 15EB 2 Fail not tested not tested not tested Keysight

Lenovo ThinkPad P1 Gen2 9
th

 Gen - Coffee Lake Intel Core i7-9850H Windows 10 Professional (x64) unknown 15EB 2 Pass not tested not tested not tested end user

Lenovo ThinkPad P52 8
th

 Gen - Coffee Lake Intel Core i7-8750H Windows 10 Professional (x64) N2CET67W (1.50), 12/15/2022 15EB 2 Pass Pass Pass Pass Keysight

Lenovo ThinkPad P53 9
th

 Gen - Coffee Lake Intel Core i7-9850H Windows 10 Professional (x64) N2NUJ21W (1.36), 3/30/2022 15EB 2 Pass Pass Pass Pass Keysight

Lenovo ThinkPad X1 Carbon Gen 8 10
th

 Gen - Comet Lake Intel Core i7-10510U Windows 10 Home (x64) N2WUJ22W (1.26), 4/27/2022 15D2 2 Pass not tested not tested not tested end user

LG gram 14Z90N-VR51J 10
th

 Gen - Ice Lake Intel Core i5-1035G7 Windows 10 Home (x64) C2ZE0210 X64, 02/02/2022 8A17 1 Pass Pass
5 N/A not tested end user

LG gram 15ZB95N 11
th

 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Enterprise (x64) unknown 15EB 1 Pass Pass
5 N/A not tested end user

Panasonic CF-LV8RD7VS 8
th

 Gen – Whiskey Lake Intel Core i5-8365U Windows 10 Professional (x64) unknown 15D9 1 Pass not tested N/A not tested end user

Panasonic CF-SV9 10
th

 Gen - Ice Lake Intel Core i5-10210U Windows 10 Professional (x64) 005142, 11/20/2023 unknown 1 Pass not tested N/A not tested end user

Toshiba Dynabook UZ63/L 8
th

 Gen – Whiskey Lake Intel Core i7-8565U Windows 10 Home (x64) v4.10, 12/16/2021 unknown 2 Pass Pass not tested not tested end user
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Thunderbolt 3 PC and Streamline Series VNA B model compatibility list

PCs with Thunderbolt 3 interface in the list are verified to work with P50xxB/P93xxB VNAs

Note:

1. 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

2. 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

3. Two VNA operation with star topology requires two Thunderbolt ports on a single PC. This topology is not available with a PC with a single Thunderbolt port.

4. Two VNA operation with daisy topology requires only one Thunderbolt port on a single PC. This topology is available with a PC with a single Thunderbolt port.

5. If PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

7. tested with Thunderbolt 3 extended PCIe card, FH5T4

8. tested with Thunderbolt 3 extended PCIe card, R9MN8

9. tested with Thunderbolt 3 extended PCIe card, 3UU05AA

10. 3UU05AA is unstable to communicte with P50xxB/P93xxB.
        Known issues: (1) Only Port-A of Controller PC can communicate with P50xxB/P93xxB, due to PCIe resource limitations.

                               (2) 2m/40Gbps Thunderbolt 3 active cable cannot communicate with P50xxB/P93xxB both on Port-A and on Port-B. 

13. tested with Thunderbolt 3 extended PCIe card, ThunderboltEX 3-TR (ASUS)

*. FPGA update pass with IO monitor workaround (#3-10-4 Step-2)

#. BSOD occurs when launching VNA firmware

PC Maker PC model name CPU Gen - Code name CPU OS                                                Microsoft Windows BIOS

Thunderbolt 

Controller 

(chipset) Gen

# of 

Thunderbolt3 

connectors

Single VNA 

operation 

(1module 

model)1

Single VNA 

operation 

(2modules 

model)2

Two VNA 

operation 

(star 

topology3)

Two VNA 

operation 

(daisy 

topology4)

Verified by

Desktop When configuring the PC on the manufacturer's website, you must select an option to include a PCIe Thunderbolt 3 card installed in the PC.

Dell Optiplex 7070 Tower 9
th
 Gen - Coffee Lake Intel Core i7-9700 Windows 10 Professional (x64) 1.0.3, 5/30/2019 15D2 2 Pass Pass Fail Fail Keysight

Dell Optiplex 7090 Tower 10th Gen - Comet Lake Intel Core i9-10900K Windows 11 Professional (x64) 1.15.0, 12/6/2021 15D2 
7,# 1 Pass Pass N/A Pass Keysight

Dell Precision 3660 Tower 12
th
 Gen - Alder Lake Intel Core i7-12700 Windows 11 Professional (x64) for Workstations 2.2.0, 2/14/2023 15D2 

7,# 2 Pass Pass Pass Pass Keysight

Dell Precision 5820 Tower 6
th
 Gen - Skylake Intel Xeon W-2135 Windows 10 Professional (x64) for Workstations 2.0.2, 2/27/2020 15D2 

8,# 2 Pass Pass Fail Fail Keysight

HP Z4 G4 6
th
 Gen - Skylake Intel Xeon W-2123 Windows 10 Enterprise (x64) P61 Ver.02.91, 3/22/2023 15D2 

9 2 Pass
10

Pass
5,10

Pass
10

Pass
5,10 Keysight

HP Z6 G4 6
th
 Gen - Skylake Intel Xeon Silver 4114 Windows 10 Professional (x64) for Workstations P60 Ver.02.91, 3/22/2023 15D2 

9 2 Pass
10

Pass
5,10

Pass
10

Pass
5,10 Keysight

Mini-PC

Asus PN62 10
th
 Gen - Comet Lake Intel Core i7-10710U Windows 11 Professional (x64) 1006, 9/15/2022 15BF 1 Pass Pass

5 N/A Pass
5 Keysight

PXIe embedded PC controller

Keysight M9038A 9
th
 Gen - Coffee Lake Intel Core i7-9850HE Windows 10 Enterprise (x64) KS08.0, 7/25/2022 15EB 2 Pass Pass Pass Pass Keysight

Mother Board

Asus Prime H670-Plus D4 12
th
 Gen - Alder Lake Intel H670 unknown 2212, 1/12/2023 15EB

 13 2 Pass not tested not tested not tested end user
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Thunderbolt 4 PC and Streamline Series VNA B model compatibility list

PCs with Thunderbolt 4 interface in the list are verified to work with P50xxB/P93xxB VNAs

Note:

1. 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

2. 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

3. Two VNA operation with star topology requires two Thunderbolt ports on a single PC. This topology is not available with a PC with a single Thunderbolt port.

4. Two VNA operation with daisy topology requires only one Thunderbolt port on a single PC. This topology is available with a PC with a single Thunderbolt port.

5. If PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

*. FPGA update pass with VNA FW A.17.05.10

PC Maker PC model name CPU Gen - Code name CPU
OS                                                               Microsoft 

Windows
BIOS

Thunderbolt Controller 

(chipset) Gen

# of 

Thunderbolt4 

connectors

Single VNA 

operation 

(1module 

model)
1

Single VNA 

operation 

(2modules 

model)
2

Two VNA 

operation 

(star 

topology
3
)

Two VNA 

operation 

(daisy 

topology
4
)

Verified by

Laptop/Mobile workstation

Acer Swift SF314-511 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Home (x64) v1.06, 7/19/2021 9A1B 1 Pass not tested N/A not tested end user

Asus TUF Gaming F15 12
th
 Gen - Alder Lake-P Intel Core i7-12700H Windows 11 Home (x64) Version 311, 8/30/2022 N/A (USB4) 1 Pass Pass

5 not tested not tested end user

Asus Zenbook UX425EA 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Home (x64) Version 309, 12/25/2021 9A1B/9A1D 2 Pass not tested not tested not tested end user

Dell Inspiron 16 Plus 7620 12
th
 Gen - Alder Lake-P Intel Core i7-12700H Windows 11 Professional (x64) 1.4.0, 7/14/2022 N/A (USB4) 1 Pass not tested not tested not tested end user

Dell Latitude 5320 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 11 Professional (x64) 1.26.2, 3/2/2023 9A1B 2 Pass Pass Pass Pass Keysight

Dell Latitude 5440 13
th
 Gen -  Raptor Lake Intel Core i7-1370P Windows 11 Professional (x64) 1.10.0, 8/11/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Latitude 5520 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 10 Professional (x64) 1.18.1, 5/9/2022 9A1B 2 Pass Pass not tested not tested end user

Dell Latitude 5530 12
th
 Gen - Alder Lake-P Intel Core i7-1265U Windows 10 Professional (x64) 1.12.0, 3/17/2023 463E 2 Pass Pass Pass Pass Keysight

Dell Latitude 5531 12
th
 Gen - Alder Lake-P Intel Core i7-12800H Windows 10 Professional (x64) 1.13.0, 10/3/2023 463E 2 Pass Pass Pass Pass Keysight

Dell Latitude 5531 12
th
 Gen - Alder Lake-P Intel Core i7-12800H Windows 11 Professional (x64) 1.13.0, 10/3/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Latitude 5550 Series 1 - Meteor Lake Intel Core Ultra 7 165U Windows 11 Professional (x64) 1.8.0, 10/9/2024 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Latitude 7420 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 10 Business (x64) 1.20.0, 10/17/2022 9A1B 2 Pass Pass Pass Pass end user

Dell Latitude 7520 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 11 Professional (x64) 1.4.4, 3/9/2021 9A1B 2 Pass not tested not tested not tested end user

Dell Latitude 7530 12
th
 Gen - Alder Lake-P Intel Core i7-1265U Windows 10 Professional (x64) 1.13.0, 3/13/2023 463E 2 Pass Pass Pass Pass Keysight

Dell Precision 3560 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 10 Professional (x64) 1.11.1, 8/13/2021 9A1B 2 Pass Pass Pass Pass Keysight

Dell Precision 3560 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 10 Professional (x64) 1.27.0, 3/17/2023 9A1B 2 Fail not tested not tested not tested Keysight

Dell Precision 3561 11
th
 Gen -  Tiger Lake Intel Core i7-11850H Windows 10 Enterprise (x64) 1.11.1, 4/14/2022 9A1F 2 Pass Pass not tested not tested end user

Dell Precision 3571 12
th
 Gen - Alder Lake-P Intel Core i7-12700H Windows 11 Professional (x64) 1.17.1, 9/18/2023 N/A (USB4) 2 Pass Pass

5 Pass Pass
5 end user

Dell Precision 3581 13
th
 Gen - Raptor Lake Intel Core i9-13900 Windows 11 Professional (x64) 1.4.1, 5/31/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Precision 3591 Series 1 - Meteor Lake Intel Core Ultra 7 165H Windows 11 Enterprise (x64) 1.14.1, 4/10/2025 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Precision 5560 11
th
 Gen -  Tiger Lake Intel Core i7-11850H Windows 10 Enterprise (x64) 1.12.0, 7/14/2022 9A21 2 Pass Pass

5 Pass Pass
5 Keysight

Dell Precision 5570 12
th
 Gen - Alder Lake-P Intel Core i9-12900 Windows 10 Professional (x64) 1.12.0, 3/15/2023 463E 2 Pass Pass Pass Pass Keysight

Dell Precision 7670 12
th
 Gen - Alder Lake-P Intel Core i7-12850HX Windows 10 Professional (x64) 1.3.1, 7/14/2022 1137* 2 Pass Pass Pass Pass end user

Dell Precision 7670 12
th
 Gen - Alder Lake-P Intel Core i9-12950HX Windows 10 Professional (x64) 1.8.0, 11/17/2022 1137* 2 Pass not tested not tested not tested end user

Dell XPS 15 9530 13
th
 Gen - Raptor Lake Intel Core i7-13700H Windows 11 Professional (x64) 1.13.0, 4/11/2024 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell XPS 16 9640 Series 1 - Meteor Lake Intel Core Ultra 9 185H Windows 11 Professional (x64) 1.10.0, 11/11/2024 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell XPS 17 9720 13
th
 Gen - Raptor Lake Intel Core i7-13700H Windows 11 Professional (x64) 1.20.0, 11/10/2023 N/A (USB4) 4 Pass not tested not tested not tested end user

Dell Vostro 7620 12
th
 Gen - Alder Lake-P Intel Core i7-12700H Windows 11 Professional (x64) 1.4.0, 7/14/2022 N/A (USB4) 1 Pass not tested not tested not tested end user
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Thunderbolt 4 PC and Streamline Series VNA B model compatibility list

PCs with Thunderbolt 4 interface in the list are verified to work with P50xxB/P93xxB VNAs

Note:

1. 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

2. 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

3. Two VNA operation with star topology requires two Thunderbolt ports on a single PC. This topology is not available with a PC with a single Thunderbolt port.

4. Two VNA operation with daisy topology requires only one Thunderbolt port on a single PC. This topology is available with a PC with a single Thunderbolt port.

5. If PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

PC Maker PC model name CPU Gen - Code name CPU
OS                                                               Microsoft 

Windows
BIOS

Thunderbolt Controller 

(chipset) Gen

# of 

Thunderbolt4 

connectors

Single VNA 

operation 

(1module 

model)1

Single VNA 

operation 

(2modules 

model)2

Two VNA 

operation 

(star 

topology3)

Two VNA 

operation 

(daisy 

topology4)

Verified by

Laptop/Mobile workstation

HP Elite x2 G2 Tablet 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 11 Professional (x64) T91 Ver.01.04.00, 5/18/2021 9A1B 2 Pass Pass

5 not tested not tested end user

HP EliteBook 830 G8 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Enterprise (x64) T76 Ver.01.04.02, 6/25/2021 9A1B 2 Pass not tested not tested not tested end user

HP EliteBook 840 Aero G8 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 10 Professional (x64) T76 Ver.01.09.01, 5/24/2022 9A1B 2 Pass not tested not tested not tested end user

HP EliteBook 840 G8 11
th
 Gen -  Tiger Lake Intel Core i5-1145G7 Windows 10 Enterprise (x64) T76 Ver. 01.06.02, 8/12/2021 9A1B 2 Pass Pass

5 Pass Pass
5 Keysight

HP EliteBook 840 14" G9 12
th
 Gen - Alder Lake-P Intel Core i5-1245U Windows 10 Enterprise (x64) U70 Ver.01.05.00, 12/30/2022 463E/466D 2 Pass Pass

5 Pass Pass
5 Keysight

HP EliteBook 840 G10 13
th
 Gen - Raptor Lake Intel Core i7-1365U Windows 11 Professional (x64) V70 Ver.01.01.08, 5/30/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

HP EliteBook 850 G8 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 10 Professional (x64) T76 Ver.01.12.10, 2/15/2023 9A1B 2 Pass Pass

5 Pass Pass
5 Keysight

HP OMEN 17-ck0906ng 11
th
 Gen -  Tiger Lake Intel Core i7-11800H Windows 11 Home (x64) unknown unknown 1 Pass not tested N/A not tested end user

HP ProBook 650 G8 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Professional (x64) T72 Ver.01.09.01, 5/13/2022 9A1B 1 Pass not tested N/A not tested end user

HP Spectre x360 Convertible 15-eb 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 11 Professional (x64) AMI F08, 7/26/2021 9A1B 2 Pass Pass

5 not tested not tested end user

HP ZBook Firefly 14 G9 12
th
 Gen - Alder Lake-P Intel Core i7-1260P Windows 10 Professional (x64) U71 Ver.01.05.00, 4/1/2023 463E/466D 2 Pass Pass Pass Pass Keysight

HP ZBook Firefly 14 G9 12
th
 Gen - Alder Lake-P Intel Core i7-1260P Windows 11 Professional (x64) U71 Ver.01.05.00, 4/1/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

HP ZBook Power 15.6 G8 11
th
 Gen -  Tiger Lake Intel Core i7-11850H Windows 10 Professional (x64) T81 Ver.01.12.00, 4/1/2023 9A1F 2 Pass Pass

5 Pass Pass
5 Keysight

HP ZBook Power 15.6 G9 12
th
 Gen - Alder Lake-P Intel Core i7-12800H Windows 10 Enterprise (x64) U97 Ver.01.01.11, 5/24/2022 463E 1 Pass Pass

5 N/A Pass
5 Keysight

HP Zbook Power 16 G11 Series 1 - Meteor Lake Intel Core Ultra 7 165H Windows 11 Enterprise (x64) W97 Ver.01.07.00, 8/22/2025 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Lenovo ThinkBook 14 Gen2 ITL 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Home (x64) F8CN47WW (V2.10), 4/8/2022 9A1B 1 Pass Pass

5 N/A not tested end user

Lenovo ThinkBook 14s Yoga ITL 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 11 Professional (x64) FNCN38WW, 4/25/2022 9A1B 1 Pass not tested N/A not tested end user

Lenovo ThinkBook 15 Gen2 ITL 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 11 Professional (x64) F8CN47WW (V2.10), 4/8/2022 9A1B 1 Pass Pass

5 N/A not tested end user

Lenovo ThinkBook 16 G7 AMD Zen 3+ Rembrant RefreshAMD Ryzen 7 7735HS Windows 11 Enterprise (x64) P6CN24WW, 1/4/2025 N/A (USB4) 1 Pass Pass N/A Pass Keysight

Lenovo ThinkPad L15 Gen2 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Enterprise (x64) R1JET55W (V1.55), 2/28/2022 9A1B 1 Pass Pass

5 N/A not tested end user

Lenovo ThinkPad P15s Gen2 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 10 Professional (x64) N34ET55W(1.55), 2/14/2023 9A1B/9A1D 2 Pass Pass

5 Pass Pass
5 Keysight

Microsoft Surface Pro 9 12
th
 Gen - Alder Lake-P Intel Core i7-1265U Windows 11 Professional (x64) Nov 2023 Update, 7/17/2023 N/A (USB4) 2 Pass not tested not tested not tested end user

MSI Prestige 15 A11SB-469CA 11
th
 Gen -  Tiger Lake Intel Core i7-1185G7 Windows 10 Home (x64) AMI E16S6IMS.119, 7/1/2022 9A1B 2 Pass not tested not tested not tested end user
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Thunderbolt 4 PC and Streamline Series VNA B model compatibility list

PCs with Thunderbolt 4 interface in the list are verified to work with P50xxB/P93xxB VNAs

Note:

1. 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

2. 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

3. Two VNA operation with star topology requires two Thunderbolt ports on a single PC. This topology is not available with a PC with a single Thunderbolt port.

4. Two VNA operation with daisy topology requires only one Thunderbolt port on a single PC. This topology is available with a PC with a single Thunderbolt port.

5. If PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

11. tested with Thunderbolt 4 extended PCIe card, 2A0B0AV

12. tested with Thunderbolt 4 extended PCIe card, 3E4N1AV

14. tested with Thunderbolt 4 extended PCIe card, ThunderboltEX 4 (ASUS)

15. tested with Dell Thunderbolt 4 extended PCIe card, 7R4VG

16. tested with HP Thunderbolt 4 extended PCIe card, 340L1AA

*. FPGA update pass with VNA FW A.17.05.10

.̂ FPGA update pass with VNA FW A.19.30.21

PC Maker PC model name CPU Gen - Code name CPU
OS                                                               Microsoft 

Windows
BIOS

Thunderbolt Controller 

(chipset) Gen

# of 

Thunderbolt4 

connectors

Single VNA 

operation 

(1module 

model)1

Single VNA 

operation 

(2modules 

model)2

Two VNA 

operation 

(star 

topology3)

Two VNA 

operation 

(daisy 

topology4)

Verified by

Laptop/Mobile workstation

Desktop When configuring the PC on the manufacturer's website, you must select an option to include a PCIe Thunderbolt 4 card installed in the PC.

Corsair ONE i300 10
th
 Gen - Ice Lake Intel Core i9-10900K Windows 11 Professional (x64) 7D29v12, 2/22/2022 1137* 2 Pass not tested not tested not tested end user

Dell Optiplex 7000 Tower 12
th
 Gen - Alder Lake-S Intel Core i7-12700 Windows 11 Professional (x64) 1.9.0, 1/10/2023 N/A (USB4) 2 Pass not tested not tested not tested end user

Dell Optiplex 7020 Tower 14
th Gen - Raptor Lake RefreshIntel Core i7-14700 Windows 11 Professional (x64) 1.11.1, 8/11/2024 1137 

15, ^ 2 Pass Pass Pass Pass Keysight

Dell Optiplex 7090 Tower 10
th
 Gen - Ice Lake Intel Core i9-10900K Windows 11 Professional (x64) 1.19.0, 7/3/2023 1137 

15,* 2 Pass Pass Pass Pass Keysight

Dell Powerredge R7610 Ivy Bridge EP Intel Xeon E5-2697 v2 Windows 10 Professional (x64) A07, 8/20/2014 1137 
15,* 2 Pass Pass Pass Pass end user

Dell Precision 3650 Tower 11
th
 Gen -  Rocket Lake Intel Core i7-11700 Windows 11 Professional (x64) 1.24.0, 7/12/2023 1137 

15,* 2 Pass Pass Pass Pass Keysight

Dell Precision 3660 Tower 12
th
 Gen - Alder Lake-S Intel Core i7-12700 Windows 11 Professional (x64) for WS 2.2.0, 2/14/2023 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Precision 3680 Tower 14
th Gen - Raptor Lake RefreshIntel Core i9-14900 Windows 11 Professional (x64) 1.9.0, 9/20/2024 1137 

15, ^ 2 Pass Pass Pass Pass Keysight

HP Envy TE02 12
th
 Gen - Alder Lake-S Intel Core i9-12900K Windows 11 Home (x64) F.16 Rev.A, 9/14/2023 N/A (USB4) 1 Pass Pass N/A not tested end user

HP Z1 G8 Tower 11
th
 Gen -  Rocket Lake Intel Core i9-11900 Windows 11 Professional (x64) T01 Ver. 02.11.00, 12/21/2022 1134

 11,
* 1 Pass Pass N/A Pass Keysight

HP Z2 G8 SFF 11
th
 Gen -  Rocket Lake Intel Core i5-11500 Windows 11 Professional (x64) T50 Ver. 01.06.01, 2/10/2023 1134

 12,
* 1 Pass Pass N/A Pass Keysight

HP Z2 G8 Tower 11
th
 Gen -  Rocket Lake Intel Xeon W-1370 Windows 11 Professional (x64) for WS T50 Ver. 01.06.00, 2/10/2023 1134

 11,
* 1 Pass Pass N/A Pass Keysight

HP Z4 G5 Tower Sapphire Rapids Intel Xeon W3-2423 Windows 10 Enterprise (x64) HP U61 Ver. 01.02.17, 1/10/2025 1137 
16, ^ 2 Pass Pass Pass Pass Keysight

HP Z8 G5 Fury Tower Sapphire Rapids Intel Xeon W5-3423 Windows 11 Professional (x64) for WS HP U61 Ver. 01.02.17, 1/10/2025 1137
 16, ^ 2 Pass Pass Pass Pass Keysight

Mini-PC

Asus NUC 14 Pro AI Series 2 - Lunar Lake Intel Core Ultra 9 288V Windows 11 Enterprise (x64) 0006.2024.1210.1520, 10/12/2024 N/A (USB4) 2 Pass Pass Pass Pass Keysight

Dell Optiplex 7090 Ultra UFF 11
th
 Gen -  Tiger Lake Intel Core i5-1145G7 Windows 10 Professional (x64) 1.4.1, 7/19/2021 9A1D 1 Pass Pass N/A Pass Keysight

GIGABYTE GB-BSi7-1165G7 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 10 Professional (x64) F9, 2/14/2022 9A1B 1 Pass Pass N/A Pass end user

Intel NUC11TNHi5 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 11 Enterprise (x64) 0064, 2/17/2022 9A1B/9A1D 2 Pass Pass

5 Pass Pass
5 Keysight

Intel NUC11TNKi5 11
th
 Gen -  Tiger Lake Intel Core i5-1135G7 Windows 10 Professional (x64) 0057, 7/7/2021 9A1B/9A1D 2 Pass not tested Pass not tested end user

Intel NUC11PAHi7 11
th
 Gen -  Tiger Lake Intel Core i7-1165G7 Windows 11 Professional (x64) 0050, 12/28/2022 9A1B/9A1D 2 Pass Pass

5 Pass Pass
5 Keysight

Intel NUC 13 Pro 13
th
 Gen - Raptor Lake Intel Core i7-1360P Windows 11 Professional (x64) ANRPL357.0027.2023.0607.1754, 7/6/2023N/A (USB4) 2 Pass Pass Pass Pass Keysight

Minisforum UM760 Slim AMD Zen 4 Phoenix AMD Ryzen 5 -7640HS Windows 11 Professional (x64) AMI, LLC. 1.08, 11/5/2024 N/A (USB4) 1 Pass Pass N/A Pass Keysight
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PC makers’ driver download page

PC Maker Driver Update page                                                                                                           Assistant tool

HP Official HP® Drivers and Software Download | HP® Customer Support HP Support Assistant

Dell Drivers & Downloads | Dell US SupportAssist

Intel Intel® Driver & Support Assistant Intel DSA

Lenovo Official Lenovo Laptop, Accessories & PC Support - Lenovo Support US Lenovo Vantage | Lenovo 

US

Asus Download Center | Official Support | ASUS USA MyAsus Application

Acer Download Acer Support Drivers and Manuals

Note: 

1. Administrator privileges are required to install the application software and drivers

2. The above links are subject to change. 

https://support.hp.com/us-en/drivers
https://support.hp.com/us-en/help/hp-support-assistant
https://www.dell.com/support/home/en-us/?app=drivers
https://www.dell.com/support/home/en-us/?app=drivers
https://www.intel.com/content/www/us/en/support/intel-driver-support-assistant.html
https://www.intel.com/content/www/us/en/download/18002/intel-driver-support-assistant.html
https://pcsupport.lenovo.com/us/en/
https://pcsupport.lenovo.com/us/en/
https://pcsupport.lenovo.com/us/en/
https://www.lenovo.com/us/en/software/vantage/
https://www.lenovo.com/us/en/software/vantage/
https://www.asus.com/us/support/download-center/
https://www.asus.com/support/faq/1039718/
https://www.acer.com/ac/en/US/content/drivers
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Proven latest versions of Key program (as of 3-Oct-2025)

Publisher Program                                                                 Version

Keysight Technologies Communication Fabric 2.2 2.2.22112.11724

Keysight Technologies Host Processor Platform 5.5.2.30000

Keysight Technologies IO Libraries Suite 2025 21.1.174

Keysight Technologies KtPUsbChassis IVI.NET Driver 1.1.11 1.1.11.0

Keysight Technologies KtPUsbChassis IVI-C Driver 1.1.11 1.1.11.0

Keysight Technologies License Manager (Keysight License Manager 5) 5.6.1.639

Keysight Technologies License Manager (PathWave License Manager) 7.4.1

Keysight Technologies License Service 5.7.0.732

Keysight Technologies VNA Series Network Analyzer firmware 19.30.21.153.0

Intel® Corporation Thunderbolt  Software 1.0.37.0

IVI Foundation IVI Shared Components 3.0.0 3.0.2828.0

IVI Foundation IVI.NET Shared Components 2.0.0 for .NET 2.0 2.0.2928.0

IVI Foundation VISA Shared Components 7.2.0 (64-Bit) 7.2

IVI Foundation VISA.NET Shared Components 7.2.0 (64-Bit) 7.2.0205
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VNA firmware revision history

For more details, go to PXIe/USB VNA Firmware Revision History | Keysight 

Release date FW revision FPGA1 FPGA2 Comment

12/9/2021 A.15.40.13 00.16 datecode: 2111155d 00.14 datecode: 2111155d Support P50xxB/P93xxB

1/7/2022 A.15.55.08 00.16 datecode: 2111155d 00.14 datecode: 2111155d

2/3/2022 A.15.55.14 00.16 datecode: 2111155d 00.14 datecode: 2111155d

2/17/2022 A.15.60.05 00.16 datecode: 2111155d 00.14 datecode: 2111155d

Feature added: Auto shutdown when in-rush voltage drop event is detected (#3-3-1-4)

Resolved: activation lic check issue (#3-10-12)

3/11/2022 A.15.60.08 00.16 datecode: 2111155d 00.14 datecode: 2111155d

4/26/2022 A.15.65.19 00.16 datecode: 2111155d 00.14 datecode:22041387

7/27/2022 A.15.75.19 00.16 datecode: 2111155d 00.14 datecode:22041387

9/6/2023 A.15.75.22 00.16 datecode: 2111155d 00.14 datecode:22041387 Resolved: missing chassis driver (#2-5-1), halt at Loading Calset (#3-10-3), hot plug-in/out issue (#3-10-6)

10/5/2022 A.15.75.26 00.16 datecode: 2111155d 00.14 datecode:22041387

11/22/2022 A.16.20.02 00.16 datecode: 2111155d 00.14 datecode:22041387

2/3/2023 A.16.20.04 00.16 datecode: 2111155d 00.14 datecode:22041387

2/17/2023 A.16.70.00 00.16 datecode: 2111155d 00.14 datecode:22081948

4/5/2023 A.16.70.01 00.16 datecode: 2111155d 00.14 datecode:22081948

5/25/2023 A.16.70.06 00.16 datecode: 2111155d 00.14 datecode:22081948

6/7/2023 A.16.70.08 00.16 datecode: 2111155d 00.14 datecode:22081948

6/21/2023 A.17.05.10 00.16 datecode: 2111155d 00.14 datecode:22081948 Resolved: Unable to program FPGA image (#3-10-4)

8/9/2023 A.17.20.08 00.16 datecode: 2111155d 00.14 datecode:22081948

8/17/2023 A.17.20.09 00.16 datecode: 2111155d 00.14 datecode:22081948

9/3/2023 A.17.25.03 00.16 datecode: 2111155d 00.14 datecode:22081948

9/15/2023 A.17.25.05 00.16 datecode: 2111155d 00.14 datecode:22081948 Support Windows 11 OS (#3-7-3)

11/6/2023 A.17.35.05 00.16 datecode: 2111155d 00.14 datecode:22081948

12/4/2023 A.17.35.10 00.16 datecode: 2111155d 00.14 datecode:22081948

This VNA firmware version is not available to download in Keysight.com

https://www.keysight.com/us/en/lib/resources/miscellaneous/pxieusb-vna-firmware-revision-history-3027380.html
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Contact Keysight – Issue sharing

This document provides lots of troubleshooting tips and will continue to improve based on your feedback.

Since Windows security is getting stricter, newer OS/BIOS might block Streamline Series VNA. In the case 

that a customer’s PC cannot use Streamline Series VNA B model, or the troubleshooting document does not

cover the symptoms of the issue, please contact Keysight.

Please include this information in the case:

• Photo/video of the symptom

• System Information w/ administrative mode

• Device Manager information

• Thunderbolt Control Center information

• Connection Expert information

• Programs and Features information (software version information)
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System Information /w administrative mode

Contact Keysight - Issue sharing

1. Enter System Information at Windows Search    6. Click File > Export   

2. Right click System Information       7. Enter sysinfo.txt at File name

3. Click Open file location        8. Click Save

4. Right click System Information

5. Click Run as administrator or

Click Run Elevated (for Keysight internal user)

6

7

8

4

5

1

2

3
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Thunderbolt Control Center information

Contact Keysight – Issue sharing

1. Enter Thunderbolt at Windows Search

2. Click Thunderbolt TM Control Center

3. Click hamburger menu

4. Click About

5. Take screenshot of Details

1

2

3

4

5
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Device Manager information

Contact Keysight – Issue sharing

1

2

3

4

5
1. Enter Device Manager at Windows Search

2. Click Device Manager

3. Click Keysight Technologies Modular Devices

4. Click P50xxB/P93xxB

      Click P50xxB/P93xxB

      Click P600X Chassis

5. Take Screenshots of Properties of P50xxB/P93xxB 

and P600X Chassis.
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Connection Expert information

Contact Keysight – Issue sharing

1. Enter Keysight Connection Expert at Windows Search

2. Click Keysight Connection Expert

3. Take screenshot of Instruments and version information

1

2

3
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Program and Features information

Contact Keysight – Issue sharing

1. Enter Control Panel at Windows Search

2. Click Control Panel

3. Click Programs

4. Click Programs and Features

5. Take screenshot of programs and its version

1

2

5

3

4
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